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Welcome to KIdDesk Family Edition!
Each year, new hardware and software reaches the public. New technology is exciting and
empowering, but it raises a new set of concerns: How can inexperienced users quickly become
comfortable? How can parents encourage children to use the computer while protecting their own
valuable data from accidental damage? Since some applications are not appropriate for all family
members, how can parents individualize access to applications-fallowing a different assortment of
applications to be available to each family member?

KidDesk Family Edition is designed to address these concerns and more. KidDesk offers a friendly,
independent interface for each member of your family, regardless of computer knowledge (or even
reading ability)! A single click on an easily recognized icon runs any application. Eleven fully functional
desk accessories (Calendar, Note Pad, Calculator, Address Card File, etc.) are available at the click of a

mouse. KidDesk even offers Voice Mail and Electronic Mail. These desk-to-desk mail systems are not
only a convenient family communication tool, but they can also be used as a stepping stone to
prepare your children for the opportunities available through online electronic mail services.

KidDesk protects your data, applications, and documents. Although no security system is foolproof,
KidDesk keeps curious youngsters and other inexperienced family members from using your applications
and accidentally changing or deleting files. KidDesk promotes hard drive security while everyone in your
family freely and independently uses the applications placed on their own desks.

Because one size never really fits all, KidDesk allows you to create a custom computing environment
that will meet the individual needs of each family member. Parents can retain unlimited access to
Windows and the hard drive. Teenagers can enjoy all of the desk accessories and the easy interface.
Young children can be given a simplified environment with limited access to applications and fewer
accessories. With KidDesk, each family member has a personalized "home base" on the computer.

Edmark's software combines leading-edge technology, proven educational methods, and a sense of joy
in using technology to increase productivity and to learn. Listening is a vital part of our development
process. We listen to parents, children, teachers—and we also want to listen to you. Please drop us a
line, describe your needs, and join us in helping your family use the power of technology to make your
computing experiences easy, educational, and enjoyable!



NowKids

Uunch Their Prx^rams

Getting Started
How to Use this Guide

How to Use this Guide

This User's Guide introduces you to all the features included in
KidDesk Family Edition and explains how to set up desks for your
family members.

The KidDesk User's Guide is divided into three sections:

■ Getting Started (pages 2-7)
This section helps you install the program.

■ Step-By-Step Setup (pages 8-17)

This section provides you with an overview of KidDesk and walks

you through basic setup steps, such as creating desks for your
family members, putting applications on the desktops, and
customizing KidDesk for your family.

■ Reference (pages 18-42)
Refer to this section for detailed information on all of the KidDesk menu commands, for

advanced options information, and for an explanation of how to use the Kid Section and the
KidDesk Accessories.

But Access Your

Windows User's Guide

s!
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Installation

System Requirements

Windows 95

486 or better

Hard disk with 4MB free

8 MB memory (RAM)

Super VGA graphics, 640x480, 256 or more colors

CD-ROM drive for installation

Windows-compatible sound card

Optional

■ Windows-compatible printer

■  Edmark TouchWindow®

■ Microphone

The Installer places a copy of KidDesk Family Edition on your hard drive and allows you to set KidDesk
to run automatically each time Windows is started. After installing the program, you can store your
CD-ROM or floppy disks for safekeeping in case you ever need to reinstall the program.

Follow these easy steps to install KidDesk Family Edition on your hard drive:

1. Turn on your computer. If Windows does not start automatically, type win at the DOS prompt and
press Enter.

2. Insert KidDesk Family Edition into your CD-ROM drive.

3. If Windows 95 AutoPlay is enabled when you insert the CD-ROM disc, the Installer will start
automatically. If it does not start automatically;
■ Choose Run from the Start menu and then type d:\setup (where d represents the letter of your
CD-ROM or floppy drive) and then click I m i.

4. Follow the on-screen instructions.

5. You will be asked to select a KidDesk startup method. To set KidCfesk to run automatically each
time Windows is started, select one of the following:
■  "Start KidDesk when starting Windows": If you select this option, KidDesk runs automatically

when you start Windows. When you exit KidDesk, you return to Windows. This is the

recommended startup method.
■  "Run KidDesk as the Windows shell": If you select this option, KidDesk replaces Windows as the

shell. This option provides the greatest hard drive security; however, you will not be able to
access Windows Explorer (your main Windows screen).

Select "Start KidDesk manually from Windows" if you do not want KidDesk to start automatically
each time the computer is turned on.
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Reinstalling KidDesk
If you install KidDesk Family Edition onto a hard drive that contains a previous version of KidDesk,
you will be given the option to add the existing desks and applications to the current version.
Note: If you use Custom Installation to install KidDesk Family Edition into the same directory as the
previous version, the old version will be erased.

Uninstalling KidDesk
If you wish to uninstall KidDesk (remove it from your hard drive), please follow these steps:
1) Use the Start menu to choose "Settings" and then "Control Panel."
2) Double-click "Add/Remove Programs".
3) Click the "Install/Uninstall" tab (if not selected).

4) Select KidDesk Family Edition and then click I



Getting Started
Technical Setup

Technical Setup
Use the information on the following pages to ensure worry-free use of KidDesk Family Edition. You
can also find useful information in the Technical Support and Troubleshooting pages of this guide and
the on-screen Help files in the KidDesk Adult Section.

GENERAL

KidDesk Family Edition uses your Windows sound, video, and printing setup. If these features do not
work in KidDesk, check their settings in Windows. Settings for most of the these features are located
in the Windows Control Panels.

To locate and open a Control Panel:
1) Use the Start menu to choose "Settings" and then "Control Panel."
2) Double-click the icon for the desired Control Panel. For example, open "Multimedia" to check

sound settings or open "Display" to check monitor settings.

SOUND

A Windows-compatible sound card and microphone are required to use the recording features of
KidDesk. The correct drivers must be installed.

If you do not get an error message while recording in KidDesk, but no sound is heard at playback,
you may have the microphone level set too low. To change the microphone level:

1) Select Start I Programs I Accessories I Multimedia I Volume Control.
2) From the Options menu, select "Properties".
3) Select "Recording", then click "OK".
4) Move the Microphone Volume slider up.

MEMORY

Running KidDesk Family Edition on a system with at least 8 MB of RAM installed is recommended. If
you experience "Out of Memory" errors or problems with performance, you can increase available
memory by:
■  Switching video resolution to 640x480, 256 colors.
■  Freeing up memory used by other applications by quitting other applications before running

KidDesk.

■  Installing more RAM.
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Switching Windows Video Resolutions
KidDesk supports 640x480 and higher resolutions. Running in higher resolutions uses more memory,
so you may wish to change your display to a 640x480 resolution.

To change your display to a 640x480 resolution:
1) Open the "Display" Control Panel.
2) Click the "Settings" tab.
3) Drag the "Desktop Area" slider to the left.
4) Click

Note: You may also wish to note the "Color palette" setting in this Control Panel and change it to
"256 Color."
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Step-By-Step Setup
Using Step-By-Step Setup you will learn how to:

■  Start KidDesk Family Edition.

■  Enter the hidden Adult Section (setup section) of the program.

■ Create personalized desks for your family members.

■  Put applications on the desks.

■ Access the desks and the KidDesk Accessories.

Note: Before you begin, you must install KidDesk Family Edition on your hard drive (page 4).

Opening Screen
If KidDesk is not already running, start KidDesk by using the Start menu and then locating KidDesk in

the "Programs I Edmark I KidDesk Family Edition" folder. (Note: Once you have installed KidDesk, the
KidDesk Family Edition CD-ROM disc or floppy disks are not required to run the program.)

The Opening Screen of KidDesk appears.

Guest

This screen will show the names and icons of the family members you add to KidDesk (since none
have been added, only a "Guest" icon appears). Before exploring the Kid Section (this Opening
Screen and the desks), let's go to the Adult Section to personalize KidDesk for your family.
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Going to the Adult Section
HI Enter the Adult Section from anywhere In KIdDesk by holding down the Ctrl

isgJL...i and Alt keys while you press "A."

The Adult Section Window appears.

Menu Bar -

Kids Card

Applications Card '

If APPI.C.1W,,, ^ :

The Kids Card shows all family members who have been added to KidDesk (currently just the guest),
and the Applications Card shows all Applications that have been added (currently, none). Click the
tabs on the cards to switch between them.

To create personalized desks for your family members, there are four main steps:

1) Create a desk for each family member.

2) Put application icons on the desks.

3) Hide some of the applications from some of the desks.

4) Set other options, such as whether exit to Windows is allowed.

Let's walk through these four steps.
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Adding Family Members to KidDesk
From the Kid menu, select Add Kid.

The Add Kid dialog box is displayed.

i  i

Type the first name of the family member you wish to create a desk for. Then use the TAB key (not the
ENTER key) on your keyboard or click in the blank box to move to the "Last Name" field and type a
name. Note: You may leave the last name blank, if you wish.

Next, decide if you want the desk to be password protected. (If the desk is password protected, the
family member must enter a password before entering the desk.) If there are items on a desk that
you do not want all family members to access, it is a good idea to protect that desk with a password.
Click <S> On if you want the desk to be password protected. You can type a password now or leave it
blank to allow the user to set the password the first time the desk is used.

The Add Kid dialog also allows you to record an audio welcome message (page 31) and control
MultiApp mode (page 33).

iff
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Finally, click I to select an icon for the family member. (Pre-readers can identify their desks by
icon instead of by name.) A list of icons is displayed.

Click the scroll arrows to see more choices; click any picture to select that icon. The icon you select
will appear on the Opening Screen and in the Picture Frame on the desk for the family member.
Click I 'A to return to the Add Kid dialog box, or:

■ Click l.*>*^ i if you wish to import a picture from another graphics file to use as the icon (page 33).

■ Click if you wish to draw or edit an icon (page 32).

After you have entered the name, chosen an icon, set the password, and configured the other
options for the family member, click I t to create a desk. The name and icon you just entered
now appear on the Kids Card.

Repeat this process (by choosing the Add Kid menu item again) for each family member you wish to
add to KidDesk.

Once you have created desks for each family member, it's time to put applications on the desks.
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Putting Applications on the Desks
After you have added your family members to KidDesk, click the Applications Tab to see the
Applications Card. The Applications Card must be showing to use the Application menu.

When you add an application to KidDesk, you are simply creating an icon in KidDesk that allows each

family member to launch that application from his or her desk. (You can remove the application from
selected desks later.) You are not copying the application or changing it in any way.

There are two ways to add applications to KidDesk. For most users, it is easiest to use the Add
Application feature.

To add an application:

1) From the Application menu, select Add Application.

2) A standard Windows 95 dialog box appears, displaying

the programs accessible through the Start menu.

3) Double-click an application's folder to find the

application icon.

4) Click once on the application icon to select it.

5) Click ■ ■. The application icon now appears on the

a  i

Badey's Bode Hoi^e 2.0
Edmark

GeoCnnputer
KkDesk F^y Edition
Mighty Math Calculating Crew

Mighty Math Number Heroes
Midity Math Zoo Zillions
Millie's Math House ZO

Samn^'s Science House 1.0
Strata Games of the World

Mighty Math Carnival Countdown O Thinkin Things 1

All Files

Applications Card.
6) If you wish to make changes to the application's settings in KidDesk (for example, changing the

application's name to something simpler for your child), click once on the application icon on the
Applications Card, then choose Application Settings from the Application menu.

A second way to add an application is to drag and drop it from Windows. (Note: This feature is not
available when KidDesk is set to run as the shell.)

To add an application by dragging and dropping:
1) Click the Applications tab.
2) Drag the KidDesk Adult Section window until you can see the Windows 95 desktop. To drag the

window, click and hold the title bar of the window and drag the mouse.
3) Locate the icon for the application you wish to add to KidDesk, then click and drag that icon onto

the KidDesk Applications Card window.
4) Repeat these steps for each application you wish to add.
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Hiding Applications from Some Desks
When you add an application to KidDesk (see above), it is automatically placed on all family members'
desks. You can hide an application from a specific desk by using the Limit Applications menu item.

For example, if you want to place the application Millie's Math House on Gabrielle's desk but not on
Pat's desk, first add Millie's to KidDesk using Add Application (as described on page 12). This places
the application on both Gabrielle's and Pat's desks. Then use Limit Applications (see below) to hide
Millie's Math House from Pat's desk.

First, switch to the Kids Card by clicking the Kids tab. Then, click to select the icon (on the Kids Card)
of the family member whose applications you would like to control. Then, select Limit Applications
from the Kid menu.

The Limit Applications dialog box for that family member appears. This dialog box shows all the
applications that have been added to KidDesk.

Stanley's Sodcn S(ones Thmkin' Things 1

Zap!Astro/^ebra

Thmkin' Science I Miite's Math House

_asLl

To hide an application from this desk, select the application by clicking its icon. An "X" appears
over the icon. To show a previously hidden application, select the application icon again, and
the "X" disappears.

When you have finished limiting the applications for this family member (hide as many as you'd like),
click I ^ Then repeat the process for other family members (select their icons on the Kids Card
and then select Limit Applications).



Step-By-Step Setup
Setting Other Options

Setting Other Options
KidDesk has many other options for personalizing the program for your family.

One of the most important options is the Kids' Exit Options. Select Kids' Exit Options from the

Options menu. This dialog box allows you to select whether or not family members can exit KidDesk
from the Kid Section.

For the greatest security, you should choose "Exit KidDesk from Adult Section only". With this option
selected, no Stop Sign appears on the Opening Screen of KidDesk, and exit is allowed only by
pressing Ctrl-Alt-A to go to the Adult Section and then choosing fx/f from the File menu.

To place a Stop Sign on the Opening Screen, which allows all family members to exit KidDesk, choose
one of the following:

■ Allow Exit to Windows: Clicking the Stop Sign quits KidDesk and returns to Windows Explorer.

■ Allow Shutdown: Clicking the Stop Sign shuts down the computer. Choosing this option and
also setting your computer to auto-start KidDesk (see page 41) creates a secure environment
that allows users to start up and shut down the computer without ever accessing Windows.

When you have chosen an option, click I l.

Note: Many other options are available for personalizing KidDesk. Please refer to pages 29-42 for a
complete description of all Adult Section settings and options.
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Returning to the Kid Section
Now that you have created a desk for each family member and added applications to the desks, it is
time to use KidO)esk\ Choose Return to Kid Section from the File menu. You are back at the Opening
Screen—but now there are icons for your family members!

Click an icon of a family member to go to that desk. The desk for that family member appears.
(Note: If you have turned on "Kid Password" for that family member, you must enter a password
before entering the desk.)

— KidDesk Accessories

— Application Icons

Click to return to the

Opening Screen.

Click to see more applications.

The desk has several parts. Across the top of the desk are the KidDesk Accessories (Calendar, Calculator,
E-Mail, Voice Mail, and more). The Stop Sign at the bottom left of the desk returns you to the Opening
Screen, where you can exit KidDesk (if exiting from the Kid Section is allowed) or go to another family
member's desk. The application icons appear across the main surface of the desk. If more than one
deskful of applications has been added, click the arrows to scroll between pages of application icons.

Launching Applications
To start an application, just single-click its icon. The program starts, and you can use it as you normally
do. When finished, just exit the application to return automatically to the desk.
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KidDesk Accessories
Finally, explore the KidDesk Accessories. Start by clicking the Pencils and Pens. A screen appears that
allows you to choose a different style of desk. Click a style that you'd like, or click the arrow to see more
choices. Don't worry! The look changes, but the same applications and KidDesk Accessories will

appear on your new desk.

Then explore the other KidDesk Accessories. Here's a brief overview:

Picture Frame (page 21)

See your icon and select or draw a new one.

r—t

!R

Uplift,

Address Card File (page 28)

Store addresses, phone numbers, birthdays,

and other important notes.

k——

r"-1
Phone

Phone (Voice Mail) (page 25)

Record voice messages with the Phone

and send them to other family members'

desks. Use the Answering Machine to listen

to incoming messages.

Mailbox (E-Mail) (page 26)

Send written messages to and receive

written messages from other family

members' desks.

Clock (page 23)

See an analog and a digital clock

and hear the time spoken.

Lamp (page 22)

Dim or brighten the screen.

Tina Friesen

Note Pad (page 27)

Write a note, decorate it with a border,

and print it out.

a' Dear Grandma.

named him Speedy I

-  ''4<

Pencils and Pens (page 22)

Select a different style of desk.

Calendar (page 24)

See a monthly calendar and day box. Enter

notes or reminder stickers on specific days.

18 "rthdoyt

illiilii

Calculator (page 23)

Use a large, on-screen calculator.

Name Plate (page 21)

Display first name only or first and last

names.
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You've just learned everything you need to know to get KidDesk up and running for your family.
For more detailed information and a description of other features and options, please refer to the
reference section of the User's Guide.

■ ^/ofDesk Accessories: Pages 21-28.

■ Adult Section Menu items: Pages 29-42.

■ Adding Applications: Pages 37-38.

■ Running Applications: Page 20.

Exiting KidDesk
To exit KidDesk, click the Stop Sign on the desk to return to the Opening Screen.
■ If the Stop Sign is displayed on the Opening Screen, click it to exit.

■ If the Stop Sign is not displayed on the Opening Screen, press ctrl + alt + A to enter the Adult
Section, then choose Ex/f from the File menu.
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Opening Screen

REFERENCE SECTION

This section of the KidDesk Guide explains how to use all the KidDesk features and options:

■ Kid Section (pages 18-28): Describes the Opening Screen, the desks, and the KidDesk Accessories

and tells you how to launch applications.

■ Adult Section (pages 29-42): Describes every menu item, all options and customizations available.

For step-by-step instructions on setting up the program, please refer to the Step-By-Step Setup section
of this Guide (pages 8-17).

Kid Section
Opening Screen
The icon and name of each family member added to KidDesk appear on the Opening Screen of the
Kid Section. (Before you add your family to KidDesk, only the Guest icon appears on this screen.
See Add Kid, page 31).

Guest

Friesen

Fnesen

Lynn
Friesen

Pat

Friesen

(After you add your family to KidDesk.)

You can disable the Guest icon (see Guest Settings, page 34); however, you may wish to leave it in so

that visiting friends can use KidDesk without affecting the other desktops.

To go to the Guest desk or another desk, click the Guest icon or another icon.

To exit KidDesk, click the Stop Sign (if displayed). Use the Options menu of the Adult Section (see
Kids' Exit Options, page 41) to choose whether or not exit from KidDesk is allowed. If no Stop Sign
is displayed, enter the Adult Section by pressing ctrl + alt + A, then select Exit from the File menu.
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Kid Passwords
You can protect each desk with a password (see Add Kid, page 31). After clicking an icon on the
Opening Screen, the correct password must be entered before going to that desk. Note: If you set an
Adult Password, that password works as a "master" password, allowing you to enter all desks without
knowing each password (see Adult Password, page 40). This is especially useful in the case of forgotten
passwords.

Setting a Password

If you have not set a password but have turned on the Kid Password for the desk, a password can be
set the first time a kid uses that desk.

Changing a Password

To change a password, click the family member's icon on the Opening Screen, then click
Enter the current password and then type a new password.

The Desk
The desk is your family member's "home base" on the computer. From here you can use the KidDesk
Accessories (Calendar, Phone, etc.), run applications, or return to the Opening Screen.

■ To run an application, click its icon.

■ To use an accessory, click its icon.

■ To return to the Opening Screen, click
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Launching Applications

Your family members can run the applications that appear on their individual desks but are prevented
from running any other applications not selected for their use. Add as many applications to the desks

as you like (see Add Application, page 37). If more than one page of applications has been added, an
arrow appears. Click the arrow to see the rest of the applications. (To rearrange the order in which

applications appear on the desk, see page 29.)

Running Applications
To run an application, just click the application's icon on the desk. Unless MultiApp mode is on (see
below), switching and minimizing applications are not allowed in applications run from KidDesk. To
return to KidDesk, quit the application.

Running Applications on CD-ROM Discs
CD-ROM-based applications are treated like other applications; before they can be launched from a
desk, they must be added to KidDesk. Click their icons on the desk to run them. Note: The
application's CD must be inserted into the CD-ROM drive.

MultiApp Mode

For advanced users, set the desk to MultiApp mode (see Add Kid, page 31) to allow the family
member to run several applications from KidDesk at one time. In MultiApp mode, switching and
minimizing applications and access to Windows Explorer are allowed. While running an application in
MultiApp mode:

■ Click the desk (displayed behind the active application's window), or use the Windows Minimize
button to minimize the application and automatically return to KidDesk. The minimized

applications appear as icons under the desk.

■ Open another application by clicking its icon on the desk. Restore a minimized application by
clicking its icon under the desk.

■ Exit the application to quit the application and return to KidDesk.

Warning: Family members should always return to KidDesk after running an application. Data loss

can occur if the computer is turned off before exiting the application and returning to the desk.
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The KidDesk Accessories
KidDesk has twelve different desk styles. Each desk offers eleven accessories—Name Plate, Picture
Frame, Lamp, Pencils and Pens, Clock, Calculator, Address Card File, Phone and Answering Machine,
Calendar, Note Pad, and Mailbox. To use an accessory, just click it!

Each desk can have its own unique set of accessories and features. Use the built-in features of
each accessory (described below) or set an accessory to run an application instead of its built-in
feature. For example, you might want to set the Calendar to run a date book application and the
Note Pad to run a word-processing application (see KidDesk Accessories, page 35).

Name Plate
Benjownln Gabrielle c Tina Friesen

The Name Plate identifies the owner of each desk and displays either the first name only or both the
first and last names.

■ Click the Name Plate to switch between first name only and both first and last names.

Picture Frame

The Picture Frame displays the kid's icon, and allows you to edit, choose, or draw an icon. Note: If the
icon editor has been turned off from the Adult Section (page 36), the Picture Frame displays the icon,
but the icon cannot be changed from the desk.

■ Click the Picture Frame to use the icon editor.

■ Click the arrows to see more icons.

■ Select a new icon by clicking it.

■ Customize the icon using the tools and color palette.

■ To select a tool, click it.

Pencil: Draws freehand. Select the pencil and a color
from the palette. Drag the pencil to draw with the
selected color.

Paint Bucket: Fills areas with color. Select the paint bucket and a color from the palette, and then
click the space you wish to fill.

Eraser: Erases to white. Drag over the area you wish to erase. Double-click to erase the entire
image.

Mi

M
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Hand: Repositions an image. Drag to move the image in the frame.

Eyedropper: Uses a color from the picture. Select the eyedropper and a color on the picture. Then,
select the pencil or paint bucket to use that color.

Click to return to the desk.

Lamp

Use the KidDesk Lamp to turn down the light on the desk.

■ Click the Lamp to dim the screen.

■ Click it again to brighten the screen.

Pencils and Pens hi I
The Pencils and Pens (or Paint) allow you to choose a new style of desk. Although the "look"changes,
information specific to the desk (such as name, icon. Address Card File entries, etc.) remains as a part
of the new desk.

■ Click the Pencils and Pens to see the

desk choices.

■ Click the arrow to see more desk

choices.

Click ̂ IP if you decide that you
do not want to change desks.

Click the desk that you want to

replace your current desk.
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Clock

The analog Clock uses hour, minute, and second hands to show the time. You can also see digital

and analog clocks simultaneously and hear the time spoken. (The KidDesk Clock displays the time

set on your computer's internal clock.)

Click the Clock to see a digital clock and hear the time spoken.

"The time is seven fifty-one."

Calculator

The Calculator allows you to access the large, on-screen calculator. Use the KidDesk Calculator as you
would a standard calculator.

■ Click buttons on the Calculator or use your keyboard to operate the Calculator. (Use the C key for
Clear; use the / key for -r; and the * key for X to operate the Calculator from the keyboard.)

Click to return to the desk.
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The KidDesk Accessories

Calendar
nI ̂iy 30 I

July

30
July
30

The Calendar on the desk shows the current date (as set on your computer's internal clock). Click it to
view the calendar for the current month, the previous month, or the following 12 months.

Click the Calendar to see the monthly calendar and day box.

NOVEMBER

Day Box

Reminder Stickers

See more stickers.

Return to desk

rODAY IS MY
BIRTHDAY!!!

1 2

d
3 4 5 6 7 won8 9

10 11 12

ft
1 3 HOTS14 15 16"0TI

17 18 19 20 21 22 23

24 25 26 27 28 29 30HOTI

Click here to remove F'rint monthly

a reminder sticker calendar,

from the currently

selected date.

.... 5ee next month.

j  Return to current month and date.

See previous month.

Click a day to select it. You can enter notes or place reminder stickers on that day.

-To place a reminder sticker, click the sticker. The sticker appears in both the day box and the
monthly calendar. To remove it, click the blank yellow reminder sticker. To see more reminder
stickers, click the arrow buttons below the stickers.

-To enter a note in the day box, type it on your keyboard. The monthly calendar will indicate a note
has been entered.

Click to print a monthly calendar. The printed calendar contains all notes (with text) and

stickers added to the on-screen calendar. Printing can be turned on or off from the Adult Section.

Click to return to the desk.



Kid Section

The KidDesk Accessories

Phone (Send Voice Mall)

The Phone allows you to "call" other desks and leave a voice message. If you do not have sound-input
capability, or if "Greetings only" is selected from the Adult Section, Voice Mail is disabled and clicking
the Phone plays a variety of greetings.

■ Click the Phone to see a list of all KidDesk users.

■ Click a kid's icon to "call" that desk. Note: Choosing "Allow sending to multiple users" in the Adult
Section lets you send one message to several desks at once (hold down the Ctrl or Shift key while
you click the icons, and then click

The Phone rings, and the outgoing message (Answering Machine greeting) from that desk plays.
The Record dialog box then appears, allowing you to leave a message.

Click IH to begin recording.
when finished.

to hear what you recorded.

to send the message and return to the desk.

Click

Click

Click [

Answering Machine (Receive Voice Mail)

The Answering Machine allows you to listen to incoming messages and record the message others
hear when they call your desk. When messages are waiting, a red light flashes. Note: If you do not
have sound-input capability, or if "Greetings only" is selected in the Adult Section, the Answering
Machine does not appear.

■ Click the Answering Machine on the desk.

Skip to next message.

Hear message. --

Messages Outgoing
Message

— Record outgoing message. This
message is played for other KidDesk
users when they "call" your desk.

Click to return to your desk. You will be asked if the messages you listened to should be
erased. (Nine messages can be saved.)



Kid Section

The KidDesk Accessories

Mailbox (E-Mail)

The Mailbox allows messages to be sent to and received from other family members' desks. Your
mailbox on the desk displays letters if unread messages are waiting.

■ Click the Mailbox to see the icons of all KidDesk users and the icons of any incoming mail.

Click to read message.

Return to the desk.

Pat-

Good luck in your school play tomorrowl Mom
and I are really looking forward to watching.
You have worked hard and we know you are
going to do a great job Break a legl

'  ' Q

Read mail from: Send mail to

Gary Fnesen
Monday, 10:34 a.m

Guest Ga^rielle Gary
Friasen Fnesen

Lynn Fnesen
Monday. 10:25 a.m

Lynn Pat
Fnesen Fnesen

Gabnelle Fnesen

Monday, 10:01 am

Click to address message.

Note: If "Allow sending

to multiple users" is

checked in the Adult

Section, you can send one

message to several desks

by selecting several icons

(hold down the Ctrl key

while you click the icons),

and then clicking l »>*«1.

Hey Gabnelle.

Let's supnse Dad tomorrow moming for his
birthday. We can make him breakfast
I'll make french toast You can decorate the

tray and make a birthday card

p s.- Donttelll

ft ̂

Reading E-Mail

■ Click an icon in the "Read mail from:'

box to read the message.

■ Click to print the message.

■ Click after you have read the

message. You will be asked if you
would like to delete the message.

Sending E-Mail

■ Click an icon in the "Send mail to:"

box to address the message.

■ Type your message.

■ Click to print the message.

■ Click to send the message.

■ Click to leave without sending

a message.



Kid Section

The KidDesk Accessories

Note Pad

The Note Pad allows you to type, decorate, and print out one-page {dtVi" x 11") notes. Use the Note
Pad to make everything from grocery lists to letters to signs.

Click the Note Pad on the desk.

Choose a border.

See more borders.

Change font size.

f1□Q
n
030
-m m 1

1^'. .-e •••
gtf Dear Grandma.
'  Thank you for the

goldfish you gave me
°  for my birthday. I have
o  named him Speedy. I

.• also liked the cake you
g ® made me.
. 0 Love,

Gabrielle

•'4(

...i... Page View

Print note. Erase all text.

Click JhA to print your note and border. The printed page looks just like what is shown in the
Page View. Printing can be turned on or off from the Adult Section.

Click to return to the desk.



Kid Section

The KidDesk Accessories

Address Card File

The Address Card File allows you to make and organize name/address cards. Each card contains a

field for name, address, phone number(s), birthday, and miscellaneous notes.

Click the Address Card File to see the cards.

BlrmdoyName
Jason Harkness June 15,1988

Notes
Has a dog named Max!

17 Spruce Street
Baltimore, MD 21146

Phone
749-0543

To add a new card, either move to a blank card, or click I ^ !: then type a name. Move from one
section of the card to another (for example from the "Name" to "Address" field) by pressing the TAB
key on your keyboard or by clicking the next section with your mouse.

As soon as you type a name, the card is filed alphabetically by name. Cards are ordered by the first
letter typed in the name field, so you can organize your cards by last name by entering (for example)
"Miller, Andrew" or by first name by entering "Andrew Miller."

■ Click a tab to see the first card in that group of letters. If no cards have been created for those
letters, a blank card is displayed.

■ Click the right or left arrow to see the next card or previous card.

Click to delete the card that is displayed.

Click ̂ ^to print. Then, click either to print the card displayed or j to print a list
containing the information on all cards. You can turn printing on or off in the Adult Section.

Click iB to return to the desk and save your new or changed entries.



Adult Section

Adult Section Window

Adult Section
Enter the Adult Section by holding down the Ctrl and Alt keys while you press "A."

Use the Adult Section to set up personalized desks for your family and to control other KidDesk options.

Adult Section Window

The Adult Section window displays the Kids Card or the Applications Card. The Kids Card displays the
kids (family members) you have added to KidDesk, and the Applications Card displays the applications
you have added to KidDesk.

■ Click the tabs to switch between the Kids Card and the Applications Card.

After you add your family to KidDesk:

fSi3S3BSEEB

iMMtinWfmtsBrt r-mssB wspaan 9«8seft

■

After you add applications to KidDesk:

Silii jOteteM*

^ ftflidteetiiiw I

telie^8 I
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musm -mm tm i
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I When the Kids Card is showing, you can use the Add Kid menu item to add your family members to
KidDesk. Use the other Kid menu items to personalize each family member's desk.

I When the Applications Card is showing, you can use the Application menu to add applications.
To remove an application or to modify its settings, select the application's icon, and then choose an
item from the Application menu.

I Rearrange the order that the applications appear on the desk by dragging and dropping their icons
on the Applications Card.

1 The File, Options, and Help menus can be used with either card showing.



Adult Section

KidDesk Menu Bar and File Menu

I Elle Kid Appliotip" Options jjelp |

Return to Kid Section

Exit

KidDesk Menu Bar

The KidDesk menu bar is the control center of the KidDesk Adult

Section. Using the five menus (File, Kid, Application, Options, and

Help), you can control every aspect of the desks that your family uses.

Many of the KidDesk menu items display a dialog box. In a dialog
box, you can enter or change information. Click I ft 1 to save any
changes you make and close the dialog box. Click i a to close
the dialog box without saving any changes and to retain the
previous settings.

If you have questions regarding the contents of a dialog box,
click j-

File Menu
Return to Kid Section: Return to the Opening Screen of the
Kid Section.

Exit: Leave KidDesk. (If KidDesk is running as the shell, slelecting Exit
shuts down your computer.)



Adult Section

Kid Menu

Add Kid

Kid Settings
Bemove Kid

Limit Applications
jCldDesk Accessories

Kid's Oocuments

'Kri 'ilMlilWti#

LJsslJ
liiTioimf^. v. .1

1

Kid Menu
Click the "Kids" tab to see the Kids Card (if it is not showing) and
to use the Kid menu. Note: The word "kid" is used to represent any
KidDesk user with a desk. Many adults add themselves (as "kids") to
KidDesk.

Add Kid

To add a family member to KidDesk and create a new desk, choose
Add Kid from the Kid menu. Use the Add Kid dialog box to choose
an icon, record or import a Welcome Message, password protect the
desk, and enable MultiApp mode.

Return to Adult Section window

without adding the new kid.

Enter nanne(s).

I.

Set a password .--1

Turn password —
Off/On.

Record a

Welcome'

Message.

- Save the new

kid and all

settings, and
return to Adult

Section window.

— Change icon.

—Turn MultiApp
mode On/Off.

Import a
Welcome

Message.

Kid Password: Click <S> on to password protect the desk. Enter a
password in the "Kid Password" box to set one, or leave the box
empty to allow the user to set the password.

Welcome Message: Click l»«rgw»tj from the Add Kid dialog box to
record a Welcome Message. The message you record is played each
time the desk is entered.

To begin recording, click . Click [S when finished.

To hear what you recorded, click ̂ .
To save your newly recorded message and return to the Add Kid
dialog box, click .J.
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Kid Menu
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Click I i from the Add Kid dialog box to import a sound file. You
can import most .WAV files.

■ Navigate to the drive and directory in which the .WAV file is stored.

■ Select the file by clicking it.

Choose Icon: Click i i from the Add Kid dialog box to choose
a new icon.

■ To see more icons, use the scroll bar.

■ To choose an icon, select it, then click L&J .

Customize Icon: Click i i from the Choose Icon dialog box to
create your own icon or to create a customized copy of the icon you
have chosen.

■ To select a tool, click it.

Pencil: Draws freehand. Select the pencil and a color from the
palette. Drag the pencil to draw with the selected color.

Paint Bucket: Fills areas with color. Select the paint bucket and a
color from the palette, and then click the space you wish to fill.

Eraser: Erases to white. Drag over the area you wish to erase.
Double-click to erase the entire image.

Hand: Repositions an image. Drag to move the image in the frame.

Eyedropper: Uses a color from the picture. Select the eyedropper
and a color on the picture. Then, select the pencil or paint bucket
to use that color.



Adult Section

Kid Menu

^FfenfeionOevSys;
AddKidbmp

pAit3onS
^ Calends fanp

Import icon: Click fiiiiiiil from the Choose Icon dialog box to
import a graphics file. These files may contain scanned pictures,
graphics created in a paint program, icons, etc.

■ Use the "List files of type" drop-down menu If bBip-'-pcKAgaAipgi M
to select which type of files to display.

■ Use the "Drive" drop-down menu to select which drive to search.

■ Select your file (by clicking it) and then click IZx3 .

■ If the file contains a —

Collection of icons: Click i. or i 1 to see the icons. Click

to select the current icon.

Large image: Click and drag to select the area of the image you
want to use as an icon. You have two options:

1. Fixed Area: Drag the icon-sized box over the area you want to
use. Click to select the area.

2. Variable Area: Drag to draw a box around any part of the picture.
The area is reduced or enlarged to fit into the icon frame. If the
"Maintain Aspect Ratio" check box is checked, dragging will be
restrained (avoiding distortion) to fit the picture into the frame. If
the "Maintain Aspect Ratio" check box is unchecked, you can
drag freely, but the image may be distorted.

MultiApp Mode: Click <S> on to enable MultiApp mode for the desk.
When MultiApp mode is on, several applications can be open at one
time, and minimizing, maximizing, and switching applications are
allowed. Minimized applications appear beneath the desk as icons,
allowing you to switch rapidly between applications. More
experienced users may enjoy the additional freedom allowed in
MultiApp mode (see Launching Applications, page 20).
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Kid Menu
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Kid Settings (includes Guest Settings)
Kid Settings: To edit settings (such as name, icon, password.
Welcome Message, and scanning) for a family member who already
appears on the Kids Card, double-click the icon on the Kids Card; or
select the icon on the Kids Card, and then choose Kid Settings from
the Kid menu.

You will see the Kid Settings dialog box, which functions in the
same way as the Add Kid dialog box (page 31).

Guest Settings: To edit the Guest settings, double-click the Guest
icon on the Kids Card; or select the Guest icon on the Kids Card,
then choose Kid Settings irom the Kid menu.

■ To remove the Guest icon from the Opening Screen of the Kid
Section, click <|) Disabled.

■ To show the Guest icon on the Opening Screen, click ^ Enabled.
You may wish to leave the Guest icon enabled, so that visiting
friends can use KidDesk without disturbing the Calendar,
applications. Address Card File entries, etc., on the other desks.

■ To record or import a Welcome Message for the Guest, click
I^MM or l »ww»« I.

■ To allow guests to print, place a check in the "Allow Printing" box.

Remove Kid
To remove a family member from KidDesk, select the icon on
the Kids Card, and then choose Remove Kid from the Kid menu.
The family member's desk is erased, including all Calendar, Note
Pad, and Address Card File entries and all Voice Mail and E-Mail
messages.



Adult Section

Kid Menu
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Limit Applications
When you add an application to KidDesk, it is automatically placed
on all family members' desks {see Add Application, page 37). To hide
an application from a specific desk, select the kid's icon on the Kids

Card, and then choose Limit Applications from the Kid menu. (For

more information on limiting applications, see page 13.)

KidDesk Accessories

Each desk has its own unique combination of KidDesk Accessories.

The accessories can perform their KidDesk functions (for example,
the KidDesk Calendar) or can be set to run other applications on
your hard drive or a CD-ROM (for example, an appointment
calendar application).

To place accessories on or to remove accessories from a family
member's desk and control the settings for the accessories, select
the kid's icon on the Kids Card, then choose KidDesk Accessories from

the Kid menu.

Most KidDesk Accessories have three settings:

Hidden: The accessory is not displayed on the desk and cannot
be used.

Showing: The accessory is displayed on the desk and performs
its ̂ /dDesk function (described on pages 21-28).

Run Application/Launch This Application: The accessory is
displayed on the desk and runs the indicated application instead of
the KidDesk function. To specify which application to run, click

i. You will use the Add Application dialog boxes (page 37)
to find and add the application. Note: You can edit the command
line of the specified application by typing in the "Launch this
application" box.



Adult Section

Kid Menu

Some of the KidDesk Accessories have additional settings:

Picture Frame: Click the "Allow icon editing" check box to turn
the icon editor off/on. When the icon editor is on, the kid can click

the Picture Frame on the desk to draw or select a new icon. When

the icon editor is off, the icon is displayed in the Picture Frame on
the desk, but it cannot be changed.

Clock: Click the "Speaking Clock" check box to turn clock
speaking off/on. When clock speaking is on (an "x" appears in the
check box), the digital clock says the time aloud.

Phone: Click "Allow Single Send" to allow the family member to
send audio messages between desks. Click the "Allow multiple
send" check box to allow one message to be sent to several desks at
once. Click "Greetings only" to disable Voice Mail and play a variety
of greetings when the Phone is clicked. Note: If "Greetings only" is
selected, the Answering Machine is not displayed on the desk.

Mailbox: Click the "Allow multiple send" check box to allow the
family member to send one message to several desks at once.



Adult Section

Application Menu

Application

Add Application
Application Settings
Bemove Application

Application Menu
Click the Applications tab to see the Applications Card (if it is not
showing) and to use the Application menu.

Add Application
To add an application to KidDesk from your hard drive or a CD-ROM
disc, choose Add Application. Applications added to KidDesk are not
copied; adding an application just tells KidDesk where to find the
application and places the application's icon on all desks. After you
add the application to KidDesk, you can use Limit Applications (page
13) to hide the application from one or more desks.

Caution: Be aware that some applications allow access to

Windows and to documents created using other applications.

Use Add Application to specify the file that KidDesk starts when
launching a program from the KidDesk desk. Many applications use
more than one file, but only one file should be added to KidDesk
for each application.

There are two ways to add applications to KidDesk. For most users,
it is easiest to use the Add Application feature. To add an
application:

1) Choose Add Application from the Application menu.
2) A standard Windows 95 dialog box appears, displaying the

programs accessible through the Start menu.

< igBadeys Book House ZO ^Mighty Math Numbe* Heroes
^Edmaik pMigh^ Math ZooZiions
I^GeoCofnpiitef i^Mffie's Math House 2.0
^KidDesk Fam^^Edikon I^Samn^s Science House 1.0
^Mighty Math CatodatingCiew I^Sliategy Games o( the WorU
^ Migh^ Math Carrwa) Countdown Thmkm' Things 1 ^ Mic|

^  a

AD Files (".")

i  .--j- i



Adult Section

Application Menu

3) Double-dick an applications folder to find the application icon.

4) Click once on the application icon to select it.

5) Click CMJ. The application icon now appears on the

Applications Card.

6) If you wish to make changes to the application's settings in KidDesk

(for example, changing the application's name to something simpler

for your child), click once on the application icon on the Applications

Card, then choose Application Settings from the Application menu.

A second way to add an application is to drag and drop it from

Windows. (Note: This feature is not available when KidDesk is set to

run as the shell.) To add an application by dragging and dropping:

1) Drag the KidDesk Adult Section window until you can see the

Windows 95 desktop. To drag the window, click and hold the title

bar of the window and drag the mouse.

2) Use Explorer to find the application you wish to add.

3) Drag the application icon from the Windows 95 window onto the

KidDesk window.

4) Repeat these steps for each application you wish to add.
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Application Menu
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Application Settings
To change an application's settings, double-click the application's
icon on the Applications Card; or select the application's icon, and

then choose Application Settings from the Application menu.

■ To change the name of the application as it appears in KidDesk,

type the new name in the Title box. The application's original file
name will not be changed on the hard drive.

■ To add or change command-line parameters, enter them in the

"Arguments" box.

■ To change the application icon as it appears in KidDesk, click

I  i (see Choose Icon, Customize Icon, and Import Icon,
pages 32-33). The application's original icon will not be changed
on the hard drive.

Remove Application
To remove an application from all desks, select the application's icon

on the Applications Card, then choose Remove Application from

the Application menu. (To hide an application from one desk, use

Limit Applications from the Kid menu, page 35). Note: When you

remove an application from KidDesk, you do not delete the

application on your hard drive or CD-ROM.
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The Options Menu

Adult Password

Screen Saver

Time Reminder

Kids' Exit Options
Startup Options
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Options Menu
Changes you make using the Options menu are global. They will
affect all family members using KidDesk.
Adult Password
To add an Adult Password required for entering the Adult Section (in
addition to Ctrl-Alt-A), choose Adult Password.
■ Type the password. You will need it to enter the Adult Section.

The Adult Password can also be used to enter any desk if a kid's
password is unknown or forgotten. Type the Adult Password
when asked for the kid's password.

■ To remove or change a password, use the Backspace key to erase
the current password, or type a new password.

Time Reminder
To set a written and/or audio Time Reminder for all kids, choose
Time ffem/nc/er from the Options menu. The reminder appears on all
desks. This feature is helpful for taking turns or limiting computer
time. (The Time Reminder may not be compatible with all
applications.)
■ To turn the reminder off, click ^ None.
■ To set the reminder to appear at a regular inten/al, click ^ Every.

Then, click the arrows to indicate a length of time. The reminder
continues to appear at that interval until it is turned off.

■ To set the reminder to appear at a specific time of day, click At.
Then, click the arrows to set the time.

■ To enter a message, type it in the message box.
■ To record an audio reminder, click liM. You can also import a

sound file. (See Welcome Message, pages 31-32.)
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The Options Menu

Kids' Exit Options
To control whether family members can exit KidDesk and access

Windows and the hard drive, choose Kids' Exit Options from the

Options menu.

Click "Exit KidDesk from Adult Section only," "Allow exit to

Windows," or "Allow Shutdown."

If you choose "Exit KidDesk from Adult Section only," no Stop Sign
appears on the Opening Screen of the Kid Section. Kids cannot exit
KidDesk to directly access the hard drive. If you choose "Allow
Shutdown," a Stop Sign appears on the opening screen of the Kid
Section. Kids can exit KidDesk, but the computer shuts down

automatically.

Caution: If you choose "Allow exit to Windows", kids are able to
access the data and applications on the hard drive. For maximum

security, choose "Exit KidDesk from Adult Section only" and use

Startup Options (see below) to set your computer to run KidDesk
automatically when it is first turned on.

Startup Options
To set the way KidDesk starts, choose Startup Options from the
Options menu.

■ To run KidDesk yourself, click "Start KidDesk manually from
Windows."

■ To set KidDesk to run automatically, choose either:

- "Start KidDesk when starting Windows": KidDesk runs as a
startup item from Windows. Each time you start Windows,
KidDesk runs. When you exit KidDesk, you return to Windows.

This is the recommended startup method. .

- "Run KidDesk as the Windows shell": KidDesk replaces the

Program Manager or Explorer as the shell. Each time you start

Windows, KidDesk runs.
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Help Menu

Contents

Search for Help on.
How to Use Help

About KldDesk...

Help Menu
The Help menu contains on-screen information about most of the

Adult Section menu items and features. Use the Help menu to
answer questions regarding dialog boxes, icons, buttons, or other
unfamiliar terms.

Contents

To see an on-screen glossary of KidDesk terms and features, choose
Contents from the Help menu. You will see an alphabetical list of
Help topics.

■ To see more topics, use the scroll bar and scroll arrows.

■ To see the information for any green, underlined word(s), just click
the word(s). You will jump to the information for that topic.

To go back to the previous topic, click ll^M.

To return to the alphabetical list of terms, click I^MM.

■ To display a list of the topics you have seen, click Then,
click one of the topics to go to that topic, or close the window to
return to the Help text.

For more information about using Help, choose How to Use Help
from the Help menu.



Troubleshooting
Problem Possible Cause Solution

Unable to print calendar. "Allow Printing" has been
turned off.

Click "Allow Printing" in K/cfDesk Accessories
dialog box (page 35).

Windows configured for incorrect
printer.

Use the Windows Printers Control Panel to select

your printer.

No sound. No sound device is installed. Install a Windows<ompatible sound device.

Application does not run
correctly from KidDesk.

Wrong file was added to KidDesk. Use Add Application (page 37) to add correct .EXE,
.BAT, or .PIF file.

Kid is able to switch from

application to Windows.
MultiApp mode is on. Turn MultiApp mode off in Kid Settings dialog box

(page 33).

Application does not
appear on kid's desk.

Application has not been
added to KidDesk.

Add the desired application using Add Application
from the Application menu (page 37).

Application has been disabled. Use Limit Applications from the Kid menu to
enable the application (page 35).

No Answering Machine
appears.

"Voice Mail" is turned off. Under "Voice Mail," in KidDesk Accessories
dialog box (pages 35-36), click "Show".

Recorded sounds are

inaudible.

Sound card's microphone input
level is set too low.

Refer to your sound card's manual for more
information. See page 6.

Time Reminder malfunctions

while running an application.
Time Reminder is not compatible
with all applications.

Use Time Reminder trom the Options
menu to turn off Time Reminder (page 40).

KidDesk does not run

automatically when
computer is turned on.

Incorrect Startup Option selected. Select "Run KidDesk as the Windows shell" or

"Start KidDesk when starting Windows" (page 41).



Help
Technical Support

KidDesk Family Edition is designed for enjoyable and easy use. If a problem does arise, first consult the

Troubleshooting page in this Guide. Please be sure to check the Help file in Adult Options for updated

technical information. If you do not find a solution, refer to Customer Information Card included in

the binder for Technical Support contact information.
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